
1

McGill University ECSE-323 Digital System Design / Prof. J. Clark

ECSE-323
Digital System Design

Lab #1 – Using the Altera Quartus II Software Fall 2008



2

McGill University ECSE-323 Digital System Design / Prof. J. Clark

Introduction                                                    .

In this lab you will learn the basics of the Altera Quartus II 
FPGA design software through following a step-by-step 
tutorial, and use it to design two simple combinational logic 
circuits.
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Learning Outcomes                                               .

After completing this lab you should know how to:

• Startup the Altera Quartus II software
• Create the framework for a new project
• Layout a schematic block/gate diagram of a logic circuit 
• Name and connect nodes and busses using the block diagram editor
• Generate a functional simulation netlist
• Create a Vector Waveform File (for simulation inputs)
• Do functional simulation of a circuit
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Table of Contents                                               .

This lab consists of the following stages:

1. Introduction
2. Startup and creation of the project framework
3. Creating a schematic diagram design file for a comparator circuit
4. Performing functional simulation of the comparator circuit
5. Sketching a block diagram and laying out the schematic for a 28- 

bit adder circuit
6. Functional simulation of the 28-bit adder circuit
7. Writeup of the lab report and uploading to WebCT
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1. Introduction                                                 . 

The lab portion of the course consists of 5 parts, each two weeks long. The bulk of the 
work will be done using the Altera Quartus II software running on the computers in the 
lab. Throughout the 5 lab experiments, you will develop all of the building blocks for the 
system, and integrate them into a complete user-friendly system, using an FPGA 
development board.

Each lab will have a number of items that the lab groups must demonstrate to a TA. The 
TA will then sign the appropriate entry on the lab grade sheet (the grade sheet can be 
found at the end of the lab description, and should be printed out). Items that needed to be 
demonstrated to the TAs are indicated in the lab description with the pencil-paper- 
checkmark icon. Once you have obtained all the necessary signatures on the grade-sheet, 
give it to one of the TAs, who will then pass it on to the course instructor for recording 
the grade.

After each lab each group must submit, electronically, a lab report to the course WebCT 
student presentation area. This report will generally describe the circuits designed during 
the lab.

http://www.theteachersguide.com/clipart/pencheck.gif
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2. Startup and creation of the project framework 

In this course you will be using commercial FPGA design software, the Altera Quartus II 
program. A slightly restricted version of this program is contained on the CD that comes 
with the course textbook, and can also be downloaded from the Altera web site (preferred, 
since the Altera site will have the most recent version). The program restrictions will not 
affect any designs you will be doing in the course, so you can install the program on your 
personal computer, so that you can work on your project outside of the lab.

The purpose of this first lab is to familiarize yourself with the Quartus program, by going 
through a step-by-step tutorial on its use. You will use it to develop two simple circuits 
using schematic capture techniques.

To begin, start the Quartus II program by either by selecting the program in the 
Windows Start menu or double-clicking on the desktop shortcut icon (if one exists).
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This is the window that 
appears on startup (this 
shows version 4.1 
downloaded from 
Altera's web site – the 
versions on the lab 
computers or on the 
textbook CD may look 
slightly different)
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The Altera Quartus II program employs a project-based approach. The goal of a Quartus 
project is to develop a hardware implementation of a specific function, targeted to an 
FPGA (Field Programmable Gate Array) device.

Typically, the project will involve a (large) number of different circuits, each designed 
individually, or taken from circuit libraries. Project management is therefore important. 
The Quartus II program aids in the project management by providing a project 
framework, that keeps track of the various components of the project, including design 
files (such as schematic block diagrams or VHDL descriptions), simulation vector files, 
compilation reports, FPGA configuration or programming files, project specific 
program settings and assignments, and many others.

The first step in designing a system using the Quartus II approach is therefore to create 
the project framework. The program simplifies this by providing a "Wizard" which 
guides you through a step-by-step setting of the most important options.
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To run the Project Wizard, click 
on the "File" menu and select the 
"New Project Wizard" entry.
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The New Project Wizard involves 
going through a series of 
windows. 

The first window, shown at right, 
is an introduction, listing the 
settings that can be applied.

After reading the text on this 
window, click on "Next" to 
proceed.
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In the second window you 
should give the project the 
following name:

gNN_lab1

where NN is replaced with 
your 2-digit group number - 
e.g. if you are in group 21, 
then call the project: 
g21_ lab1
Use this naming convention 
throughout the course for all 
of your designs.

Note: g00_ will be used for 
designs developed by the 
course instructors

The working directory for your project will be 
different than that shown here. Use your network 
drive for your project files. Do not use directories 
local to the computers in the lab - since these might 
be erased, and can be accessed by other students.

C:/altera/dsd/projects/ 

g00_lab1

g00_lab1
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You will add files later, so 
for now, just click on 
"Next".
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This dialog box permits the 
designer to specify 3rd- 
party tools to use for 
various parts of the design 
process.

We will not be using any 
tools other than those 
provided by the Quartus II 
program, so just click on 
"Next".
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In later labs we will be downloading the designs to an FPGA device on the Altera 
development board. These devices belong to the Cyclone II family of FPGAs, with part 
number:

EP2C20F484C7

So, to ensure proper configuration of the FPGAs in future labs, select this device.
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The final page in the New Project Wizard is a summary. 
Check it over to make sure everything is OK (e.g. the 
project name, directory, and device assignment), then click 
on the Finish button.
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To get some practice with Quartus, we will start by designing a simple 6-bit comparator circuit, 
which we will name gNN_comp6 (where, as with the project name, NN is to be replaced with the 
group number).

The gNN_comp6 circuit has two 6-bit inputs, A and B, and a single 1-bit output, AeqB. 
The output is to be high when the two inputs have exactly the same values, and be low otherwise.

The boolean equation for the output in terms of the input is easy to derive, and is:

AeqB = (A(5) xnor B(5)) and (A(4) xnor B(4)) and (A(3) xnor B(3)) 
and (A(2) xnor B(2)) 

and (A(1) xnor B(1)) and (A(0) xnor B(0))

Verify for yourself that this boolean equation does in fact represent the desired function.

3. Creating a schematic diagram design file
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In this course, we will learn two methods for describing circuits to be implemented:  

• gate-level schematic diagrams
• VHDL descriptions. 

Schematic diagrams are graphical descriptions of the circuit, while VHDL uses 
textual descriptions.

In this lab we will learn how to describe a circuit via a schematic diagram. 
We will learn how to describe circuits with VHDL in the next lab.

Let us now create a schematic diagram design file for the 6-bit comparator.
We start by opening a new block diagram window…
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1. Click and hold on the "File" 
menu of the main Quartus 
window.

2. Select the "New" menu item. 
The dialog box shown at right 
will popup.

3. In the dialog box, select "Block 
Diagram/Schematic File" and 
click on "OK".
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A new window will 
appear in the main 
area of the Quartus 
window. You will 
draw your circuit 
schematic in this new 
window.

A vertical toolbar will 
also appear, containing 
shortcuts for 
commands relevant to 
drawing schematics.
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Click on the toolbar item that is shaped like an 
AND gate. This will bring up the "symbol" 
window that will allow you to select which 
symbol to add to your schematic drawing.

Note: The symbol 
window can also be 
opened by double- 
clicking anywhere 
within the 
schematic window. 
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We want to add an XNOR gate symbol to our schematic. This can be done in 
two ways. The first way is to expand the library directory to the 
primitives/logic directory and then scroll down to the xnor item and select it.

The second way is to type the 
symbol name directly into the 
Name box. You do not have to 
select the directory - the 
program will search the 
directory tree for the symbol. 

Finally, click on OK to complete the selection.



22

McGill University ECSE-323 Digital System Design / Prof. J. Clark

After clicking on OK in the Symbol window, a floating image of an XNOR 
gate will appear in the schematic window. As you move the mouse, the 
symbol will follow. Position the symbol where you would like it to be and 
left-click the mouse. The symbol will now be placed onto the schematic. 

Your schematic should now look something like the figure below:
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Our design for the 6-bit comparator requires six instances of the XNOR gate.
We could repeat the symbol search process five more times, but there is an easier, 
faster way to enter the other five XNOR gates. 

The faster way is to use copy-and-paste. To copy a symbol, left-click on it, to select 
the symbol, and then press Control-c on the computer keyboard. Then left-click the 
mouse with the cursor positioned at the location where you want the new symbol 
instance to be placed. Then press Control-v on the computer keyboard to paste the 
symbol at this location.

Do this copy-and-paste 
twice, to end up with 3 
XNOR gates arranged as 
shown. Then select the 
group of three and repeat 
the copy-and-paste, to 
leave 6 XNOR gates. 
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We need to AND together the outputs of the 6 XNOR gates. This can be 
done with two 3-input AND gates and one 2-input AND gate.

Search the primitive symbol library for the appropriate gates and 
instantiate them.
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Before connecting the gates, we should enter the input and output ports.
This is done by instantiating symbols named "input" and "output". We 
need 2 input ports and 1 output port.
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We now need to connect all of the gates together and hook them up to 
the input and output ports.

There are two ways that we can connect nodes in the schematic:

1. Drawing wires between two nodes using the orthogonal node tool.
2. Giving two different nodes the same name or label.

The first approach is best when making short connections between neighboring symbols, 
or when you want to make it immediately obvious from looking at the schematic that two 
nodes are connected.

The second approach is the most convenient way of connecting busses (which are 
collections of individual nodes or wires). The software assumes that two nodes with the 
same name are electrically connected.
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To draw wires between two nodes using the orthogonal node tool first select the tool 
from the toolbar to the left of the window. This tool allows to draw wires which run 
horizontally or vertically. When this tool is selected, the cursor changes into a crosshair.
To draw a wire, position the cursor over the place where you want the wire to begin, and 
left-click the mouse. Then, while holding the mouse button down, drag the cursor to the 
place where you want the wire to end, then release.
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Practice drawing lots of wires between various places. You can delete a wire by selecting 
the "Selection and Smart Drawing Tool" (the arrow shaped icon), clicking on the wire to 
select it, and then pressing the Delete key. You can move symbols by selecting them 
(with the arrow tool) and dragging them to the desired location.

Drag the output pin symbol to the right of the third 3-input AND gate, and wire up the 
AND gates to the outputs of the XNOR gates. Don't wire up the inputs of the XNOR 
gates, instead, we will connect these using node naming.

Note: this diagram shows a 
7-bit comparator – your 
circuit will use only 6 bits
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In order to use node naming as a connection 
technique, we must name the nodes we want 
connected. Let us begin by naming the input 
busses. To do this, double-click on the left- 
most part of one of the input symbol. This 
should highlight the input name (this can be a 
bit tricky, so get the TA to help if you can't 
manage to select the name field). You can 
also set the name by right-clicking on the 
symbol and selecting the "Properties" menu 
item, and filling in the name field there. 

Name the inputs as A[5..0] and B[5..0] (rather 
than as A[6..0] and B[6..0] as shown in the 
figure to the left). Also name the output as 
AeqB.

The name A[5..0] means that A is a bus with 
6 wires, having indices of 5,4,…,0. The node 
named A[5] corresponds to the Most- 
Significant-Bit (MSB) of A, and A[0] to the 
Least-Significant-Bit (LSB) of A.
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Use node naming to connect the 
XNOR gates to the input symbols. To 
do this, connect short wires to the 
XNOR input points, as shown in the 
figure to the right. Now, immediately 
after drawing a wire, type in the 
desired name. You can also select the 
wire later and type in the name then, 
or select the wire and right-click and 
select Properties and change the name 
in the Properties dialog box.

Since we have given the wire 
connected to the first input of the top 
XNOR gate the name A[5], it will 
automatically be connected to the 
MSB of the input symbol named 
A[5..0]
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This completes the entry of the schematic for the g00_comp6 circuit. 
Show your schematic to the TA and have him or her sign your 
grade sheet.

http://www.theteachersguide.com/clipart/pencheck.gif
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You should now save the design, using the "Save As" item in the File menu. 
Actually, you can do this at any time, and it is a good habit to save regularly - just in case.

Call your file  "gNN_comp6.bdf " where NN is replaced by your group number.

Make sure that the "Add file to current project" box is selected.
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So that the circuit gNN_comp6 can be used as a component in other circuits, we need to 
create a symbol for it. This is done by selecting the "Create/Update" menu item in the 
"File" menu, and then selecting the  "Create Symbol Files for Current File" menu item. 
This will produce the following message if everything was OK:
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TIME CHECK

You should be at least this 
far at the end of your first 
2-hour lab period.
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Open a new block diagram file, and insert an instance of your gNN_comp6 
block. Note that this block now appears in the Libraries list, under the 
folder "Project".
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Add some inputs and outputs and connect them using bus Naming, as shown in the figure 
below. 

Save the file as "gNN_lab1.bdf" (the name of this file should be the same as the name you 
gave to your project when you ran the New Project Wizard at the beginning of the lab).
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4. Performing Functional Simulation of the Project

Once you have your circuit described in a schematic diagram (or, in later labs, in a VHDL 
description) you should simulate it.

The purpose of simulation is generally two-fold:

1. To determine if the circuit performs the desired function
2. To determine if timing constraints are met

In the first case, we are only interested in the functionality of our implementation. We do 
not care about propagation delays and other timing issues. Because of this, we do not 
have to map our design to a target hardware. This type of simulation is called functional 
simulation. This is the type of simulation we will learn about in this lab.

The other form of simulation is called timing simulation, or hardware simulation. It 
requires that the design be mapped onto a target device, such as an FPGA. Based on the 
model of the device, the simulator can predict propagation delays, and provide a 
simulation that takes these into account. Thus, the timing simulation may produce results 
that are quite different from the purely functional simulation.
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To begin setting up to do a functional simulation, select the "Simulator 
Tool" item in the "Tools" menu.
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The "Simulator Tool" window will appear…
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Click on the "Generate Functional Simulation Netlist" button in the simulator 
tool window. This will analyze the circuitry in the project and extract a set of 
logical equations which describe the functionality of the circuit.
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When running a simulation it is useful to have a means of setting the inputs to certain 
patterns, and of observing the outputs' responses to these inputs.

In Quartus, these tasks are done through graphical display of a "Vector Waveform File" 
(.vwf). To create a new vwf file, select the "New" command from the "File" menu.

Select the "Vector 
Waveform File" entry 
and click on OK.
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An empty waveform editor window will appear, as shown below.
It contains two primary display panes - the left hand pane shows the name of the nodes or 
busses being displayed, and their value at the time indicated by the time-bar, and the right 
hand pane shows the waveform - which is the node value as a function of time.

When the VWF is first created, the waveform window will be empty. So, the next thing we 
must do is specify the nodes and busses that are to be displayed…
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Before specifying the nodes to be displayed in the simulator, we must do a Compilation of 
the design. To do this, select "Compiler Tool" from the "Tools" menu.
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The compiler window will appear. In order to do a functional simulation we do not need to 
do a complete compilation. We only need to do the first part, Analysis & Synthesis. To run 
the Analysis/Synthesis, click on the left-most icon in the Analysis & Synthesis block.
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On completion the compiler window should look like that shown below.

You can now go back to the simulator window and insert some nodes.
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To insert some nodes and busses into the waveform editor window, position the 
mouse cursor over the left part of the Waveform editor window (the part which 
says "Name" and "Value"). Right-click the mouse, and select the "Insert Node or 
Bus…" menu item. A dialog window will popup as shown below. 

If you know the name of the node that you want to add then you can type it in to 
this window. But at the beginning, when you have a lot of nodes to enter, or when 
you don't know the name of the node, it is better to use the "Node Finder".

To use the node finder, click on the Node Finder button…
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When you click on the Node Finder button, the following window appears. Make sure 
that the Filter: is set to "Design Entity (all names)", and click on the "List" button.
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When you click on the List button, the "Nodes Found" pane on the left side of the Node 
Finder window is filled with all of the nodes in the design entity. You can now select 
individual nodes to be shown in the simulation. Selection of multiple nodes is done in the 
same way as selecting multiple files in the Windows File Explorer (i.e. ctrl-click to 
select). Once you have all the files you want selected, click on the ">" button to transfer 
these to the "Selected Nodes" pane.
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For this case, the only nodes we care about during simulation are the input busses A and 
B, and the output node AeqB. We could have also selected the individual bus nodes, A[0], 
A[1], A[2], etc., but it is more convenient to treat them as a whole bus.

After pressing the ">" button 
we get the selected nodes 
appearing in the right hand 
pane.

Finish by clicking on OK
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Returning from the Node Finder dialog, the "Insert Node or Bus" window looks as shown 
in the figure below.

Click on OK to return to the Simulator window.
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After insertion of the selected nodes, the Simulator window now looks as in the figure 
shown below. Note that A and B are both set to zero and the value of AeqB is X, 
indicating an undefined value (as is expected, since we have yet to run the simulation).

The next step is to specify test input waveforms for the input signals A and B.

There are 2^12 possible input patterns (4096), which is a lot to test, but the computer is 
doing all of the work.
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First, set the end time for the simulation, by selecting 
the "End Time" item in the Edit menu. A window will 
popup, allowing you to specify the time at which the 
simulation will end.

Set the time to 655360 ns (which is 2^12 x 40ns x 4).
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Next, select bus A by left-clicking on its name in the left-hand pane. When it is 
selected, the entire row will be highlighted.

Now, click on the "Count Value" button in the left-hand vertical toolbar. This is the 
button with the "C" inside of a pair of crossed lines.
This will allow you to fill the waveform for A with a binary count sequence.
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Clicking on the "Count Value" toolbar button brings up a dialog window with two tabs. 
Select the "Counting" tab. The window shown in the figure below will appear. Set the 
"Start value" to 0000000 and the "Increment by" value to 1 as shown (these are the default 
values).
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Then select the "Timing" tab. The window shown below will appear. 
Set the "Count every" setting to 40.0 ns as shown. This will create a 
waveform which changes every 40 ns.

Click on OK to finish.
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Repeat for bus B. The settings should be the same, except that in the Timing tab view, set 
the "Multiplied by" setting to 64. This means that the count sequence for B will change 
every 2560 ns, which is 64 (2^6) times slower than for A. In this way we get a sequence of 
the 2^12 possible different values for the combination of A and B.

64
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After specifying the count values, the waveforms for A and B will look similar to 
that shown in the figure below. Note that B changes more slowly than A, as desired, 
and that all 4096 possible combinations of the values of A and B are produced (and 
will be repeated four times).
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Select "Save As" from the file menu, and save the waveform file as "gNN_lab1.vwf".

We can rearrange the ordering of the waveforms displayed in the simulation window. This is done 
by selecting the waveform to be moved, then by left-clicking on it, and dragging it to the desired 
new position, while keeping the mouse button held down. In the diagram below, we have swapped 
the positions of waveforms B and AeqB, so that waveforms A and B are adjacent.
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Once your waveforms have 
been setup, return to the 
Simulator Tool window. 
Make sure that the 
Simulation mode is set to 
"Functional", then click on 
the Start button to run the 
simulation.

(Note: you may have to re- 
run the "Generate Function 
Simulation Netlist" before 
starting the simulation)
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After the simulation finishes, the output node AeqB, which was previously undefined, 
should now be filled in with properly defined values. Look at the values for AeqB and 
see that they are correct, given the inputs A and B (i.e. it should be high when A=B)

Show your simulation results to the TA and have him or her sign your grade sheet

http://www.theteachersguide.com/clipart/pencheck.gif
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TIME CHECK

You should be at least this 
far at the end of your second 
2-hour lab period.
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5. Design of a 28-bit adder
For the course project you will need a circuit that will take in two 
28-bit values, X, Y, and provide an 29-bit output, Z, which 
represents the sum of X and Y. 

Begin your design by first designing a one-bit full-adder. You can 
use the design shown in the textbook, if you don’t already know 
how to construct a full adder out of simple gates.

Using the techniques you learned in the first part of the lab, create a 
new bdf file into which you will draw the schematic diagram for 
the circuit. Call your circuit block gNN_full_adder where NN is 
your group number.
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Once you have the schematic of the full adder module entered 
into Quartus, create a symbol for it. 

Show the schematic to your TA and have him or her sign 
your grade sheet.

Next, create another  bdf file into which you will draw the 
schematic diagram for the 28-bit adder circuit. Call this 
circuit block gNN_28bit_adder where NN is your group 
number.

Using the full adder module you just created, draw the 
schematic of the 28-bit adder. When you are done, show the 
schematic to your TA and have him or her sign your grade 
sheet. 

http://www.theteachersguide.com/clipart/pencheck.gif
http://www.theteachersguide.com/clipart/pencheck.gif
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TIME CHECK

You should be at least this 
far at the end of your third 
2-hour lab period.
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6. Functional simulation of the 28-bit adder circuit

Once you have the schematic of the full adder module entered into Quartus, 
create a symbol for it. 

Then carry out a functional simulation of the circuit, using the same approach 
used earlier to simulate the 6-bit comparator circuit. It will take too long to test 
all possible (2^56) input cases, so just simulate the circuit on 4 test cases:

Case 1: X = all zeroes, Y = all zeroes
Case 2: X = all ones, Y = all ones

Case 3,  4:  values of your choosing

After simulation, verify that your circuit works properly for the input patterns 
that you presented. If the circuit gives erroneous results, you will have to go 
back to your schematic and check for errors.

When you have completed the simulation, show the resulting vector 
waveform display to your TA and have him or her sign your grade sheet.

http://www.theteachersguide.com/clipart/pencheck.gif
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TIME CHECK

You should be this far (i.e. 
have completed the lab) at 
the end of your fourth 2- 
hour lab period!

NOTE: If you finish ahead of time start work on Lab 2!
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9. Writeup the Lab Report                                         .

Write up a short report describing the gNN_28bit_adder circuit that you 
designed in this lab. This report should be done in html or pdf, or in Microsoft 
Word (pdf format is preferred!).

The report must include the following items:

• A header listing the group number (and company name if you have one), the 
names and student numbers of each group member.
• A title, giving the name (e.g. g00_28bit_adder) of the circuit.
• A description of the circuit's function, listing the inputs and outputs. Provide a 
pinout or symbol diagram.
• A gate level schematic diagram of the circuit. 
• A discussion of how the circuit was tested, showing representative simulation 
plots. How do you know the circuit works correctly?

The report is due one week after the end of the 2-week lab period, at 
midnight.
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10. Submit the Lab Report to WebCT                  .

The lab report, and all associated design files must be submitted, as an assignment 
to the WebCT site. Only one submission need be made per group (both students will 
receive the same grade!).

Combine all of the files that you are submitting into one zip file, and name the 
zip file gNN_LAB_1.zip (where NN is your group number).
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Grade Sheet for Lab #1                             Fall 2008.

1. Schematic diagram for the 6-bit comparator                                                  .
2. Waveform Vector File display for the 6-bit comparator                                            .
3. Schematic diagram for the full adder circuit                    .   
4. Schematic diagram for the 28-bit adder circuit                                               .
5. Waveform Vector File display for intlog2 circuit                .

Group Number:                         .
Group Member Name: . Student Number:                                 .
Group Member Name: . Student Number:                                 .

Each part should be demonstrated to one of the TAs who will then give a grade and sign the 
grade sheet. Grades for each part will be either 0, 1, or 2. A mark of 2 will be given if 
everything is done correctly. A grade of 1 will be given if there are significant problems, but an 
attempt was made. A grade of 0 will be given for parts that were not done at all, or for which 
there is no TA signature.

Marks

TA Signatures

http://www.theteachersguide.com/clipart/pencheck.gif
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